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Preface

Thank you for purchasing this Topcon product. The materials available in this Manual (the “Manual”) have been prepared by
Topcon Positioning Systems, Inc. (“TPS”) for owners of Topcon products, and are designed to assist owners with the use of the
receiver and its use is subject to these terms and conditions (the “Terms and Conditions”).

Please read the terms and conditions carefully.

Terms and Conditions

Use

This product is designed to be used by a professional. The user should have a good knowledge of the safe use of the product and
implement the types of safety procedures recommended by the local government protection agency for both private use and
commercial job sites.
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Copyrights

All information contained in this Manual is the intellectual property of, and copyrighted material of TPS. All rights are reserved.
Do not use, access, copy, store, display, create derivative works of, sell, modify, publish, distribute, or allow any third party access
to, any graphics, content, information or data in this Manual without TPS’ express written consent and may only use such
information for the care and operation of the receiver. The information and data in this Manual are a valuable asset of TPS and
are developed by the expenditure of considerable work, time and money, and are the result of original selection, coordination
and arrangement by TPS.
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Trademarks

GR-5, TRU™, Magnet™, Pocket-3D™, Topcon® and Topcon Positioning Systems™ are trademarks or registered trademarks of TPS.
Windows® is a registered trademark of Microsoft Corporation. The Bluetooth® word mark and logos are owned by Bluetooth
SIG, Inc. and any use of such marks by Topcon Positioning Systems, Inc. is used under license. Other product and company names
mentioned herein may be trademarks of their respective owners.

Disclaimer of Warranty

EXCEPT FOR ANY WARRANTIES IN AN APPENDIX OR A WARRANTY CARD ACCOMPANYING THE PRODUCT, THIS MANUAL AND
THE RECEIVER ARE PROVIDED “AS-IS.” THERE ARE NO OTHER WARRANTIES. TPS DISCLAIMS ANY IMPLIED WARRANTY OF
MERCHANTABILITY OR FITNESS FOR ANY PARTICULAR USE OR PURPOSE. TPS AND ITS DISTRIBUTORS SHALL NOT BE LIABLE FOR
TECHNICAL OR EDITORIAL ERRORS OR OMISSIONS CONTAINED HEREIN; NOR FOR INCIDENTAL OR CONSEQUENTIAL DAMAGES
RESULTING FROM THE FURNISHING, PERFORMANCE OR USE OF THIS MATERIAL OR THE RECEIVER. SUCH DISCLAIMED
DAMAGES INCLUDE BUT ARE NOT LIMITED TO LOSS OF TIME, LOSS OR DESTRUCTION OF DATA, LOSS OF PROFIT, SAVINGS OR
REVENUE, OR LOSS OF THE PRODUCT’S USE. IN ADDITION TPS IS NOT RESPONSIBLE OR LIABLE FOR DAMAGES OR COSTS
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INCURRED IN CONNECTION WITH OBTAINING SUBSTITUTE PRODUCTS OR SOFTWARE, CLAIMS BY OTHERS, INCONVENIENCE, OR
ANY OTHER COSTS. IN ANY EVENT, TPS SHALL HAVE NO LIABILITY FOR DAMAGES OR OTHERWISE TO YOU OR ANY OTHER
PERSON OR ENTITY IN EXCESS OF THE PURCHASE PRICE FOR THE RECEIVER.
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License Agreement

Use of any computer programs or software supplied by TPS or downloaded from a TPS website (the “Software”) in connection
with the receiver constitutes acceptance of these Terms and Conditions in this Manual and an agreement to abide by these
Terms and Conditions. The user is granted a personal, non-exclusive, non-transferable license to use such Software under the
terms stated herein and in any case only with a single receiver or single computer. You may not assign or transfer the Software
or this license without the express written consent of TPS. This license is effective until terminated. You may terminate the
license at any time by destroying the Software and Manual. TPS may terminate the license if you fail to comply with any of the
Terms or Conditions. You agree to destroy the Software and manual upon termination of the use of the receiver. All ownership,
copyright and other intellectual property rights in and to the Software belong to TPS. If these license terms are not acceptable,
return any unused software and manual.

Confidentiality

This Manual, its contents and the Software (collectively, the “Confidential Information”) are the confidential and proprietary
information of TPS. You agree to treat TPS’ Confidential Information with a degree of care no less stringent that the degree of
care you would use in safeguarding your own most valuable trade secrets. Nothing in this paragraph shall restrict you from
disclosing Confidential Information to your employees as may be necessary or appropriate to operate or care for the receiver.
Such employees must also keep the Confidentiality Information confidential. In the event you become legally compelled to
disclose any of the Confidential Information, you shall give TPS immediate notice so that it may seek a protective order or other
appropriate remedy.
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Website; Other Statements

No statement contained at the TPS website (or any other website) or in any other advertisements or TPS literature or made by
an employee or independent contractor of TPS modifies these Terms and Conditions (including the Software license, warranty
and limitation of liability).
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Safety

Improper use of the receiver can lead to injury to persons or property and/or malfunction of the product. The receiver should
only be repaired by authorized TPS warranty service centers. Users should review and heed the safety warnings in an Appendix.

Miscellaneous

The above Terms and Conditions may be amended, modified, superseded, or canceled, at any time by TPS. The above Terms and
Conditions will be governed by, and construed in accordance with, the laws of the State of California, without reference to
conflict of laws.
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Manual Conventions Y
0]
—tn
This manual uses the following conventions: %
Convention Description Example ()
Bold Menu, or drop-down menu selection File » Exit (Click the File menu and click Exit)
Name of a dialog box or screen From the Connection screen...
Button or key commands Click Finish.
Mono User supplied text or variable Type guest, and click Enter.
Italic Reference to another manual or help document Refer to the Topcon Reference Manual.

Further information to note about system configuration, maintenance, or setup.

Supplementary information that can have an adverse affect on system operation, system performance, data
integrity, measurements, or personal safety.

Notification that an action has the potential to result in system damage, loss of data, loss of warranty, or
personal injury.

QO G
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Introduction

Topcon’s GR-5 receiver is a compact and lightweight GNSS receiver for static and kinematic applications. The receiver design
includes a GNSS receiver board based on Vanguard™ technology, which provides unlimited tracking ability. The GR-5 delivers
world-class positioning and navigation capability to your application by tracking signals from multi-constellation satellite systems,
including GPS, GLONASS, and SBAS.

Using a full wave antenna, the GR-5 can receive and processes multiple signal types, including the latest GPS L2C and GLONASS C/A
L2, GPS L5 and GALILEO? signals. Driven by the augmented Paradigm ™ G3 chip, the board provides 216 universal channels and
up to 100 Hz position and measurement update rates.

GNSS tracking capabilities, dual-frequency RTK, SBAS functionality, extensive communication capabilities, removable memory for
files combine to provide a positioning system efficient, secure, and appropriate for any survey.

Several other unique features, including multipath mitigation, adjustable phase-locked loop (PLL) and delay-locked loop (DLL)
parameters, offer a reliable and versatile reception of weak signals even in degraded signal environments. The receiver provides
the functionality, availability, and integrity.

The GR-5 offers complete IP67 protection against dust and water ingress, in addition to superior vibration and shock resistance.
The Topcon communication interface allows you to quickly integrate Topcon’s premium GNSS performance within new systems
and quickly deliver world-class positioning and navigation support to your applications.

1. The GR-5 tracks the GIOVE-A and GIOVE-B test satellites. The signals from these satellites are used for signal evaluation and test
purposes only.
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GR-5 Features

The GR-5 receiver’s advanced design reduces the number of cables
required for operation, allowing for a simplified setup and less parts
to keep track of. The GR-5 receiver features the following:
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® Two external, detachable batteries

® USB and serial data ports

® External memory card slot

® Internal radio modem

® Bluetooth® wireless technology module

® Interface for controlling viewing data logging through the
LED display

® SIM card slot
The GR-5 can be configured in a variety of ways, depending on your
project requirements. Typically, the GR-5 supports the following
operation modes:

® Static post-processing

® Base and Rover RTK

® Network Rover RTK

® SBAS-enabled navigation

Figure 1: GR-5 Receiver

GR-5 Features P/N: 7010-1004 2




Unpacking Your Receiver Kit

This section describes the documentation, standard kit components, and accessories (depending on your purchase) that
accompany your receiver. When you unpack your receiver kit, verify you received the items listed in this section. If any items

are missing or damaged, contact your Topcon dealer or Topcon technical support. See “Getting Technical Support” on page 6.

® Standard components are illustrated in Figure 2.
® Receiver accessories are illustrated in Figure 3.
® Receiver documentation is listed on page 5.

Supplied System Components

i -

Power Cable USB Cable Serial Cable Receiver Power Cable

GR-5 Manual CD GPS+Software CD Carrying Case Warmranty Card Battery Charger

Figure 2: Standard System Components that are Included with Your Receiver
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The GPS+ Software CD includes USB drivers, which you need to install to use the USB port for
= communications.
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Accessories

Topcon offers a wide variety of accessories (see Figure 3) specially designed to improve system flexibility and job site efficiency.
For more details on the optional accessories available for GR-5, contact your Topcon dealer.

_:_E_‘ B -‘:.'_'_-‘._ . _
T e, & & 8
@ S
Power Supply Unit Modem Antenna Universal Tribrach Receiver Power Cable Quick Disconnect
and Adapter and Adapter
=3 "
Cradle-to-Receiver AA Battery Pack Cradle-to-Receiver
Charging Cable Charging Cable
Figure 3: Receiver Accessories
P/N: 7010-1004 4

Unpacking Your Receiver Kit




Technical Documents

The GR-5 Manual CD includes two manuals (listed below) that help you set up and use your new receiver quickly and efficiently.

® GR-5 Operator’s Manual — An on-screen help document that contains detailed information on how to use your new
receiver.

® Topcon Receiver Utility (TRU) Reference Guide — An on-screen help document that contains detailed information on how
to use the TRU software included on the GPS+ Software CD. For more information about the TRU software, see “Using
Topcon Software With Your Receiver”.

Using Topcon Software With Your Receiver
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Use the GR-5 receiver in conjunction with the Topcon Receiver Utility (TRU) and MAGNET Field™ or Pocket-3D applications for
a precision positioning solution. Topcon software enables you to configure the receiver and other external devices, manage files,
collect data, and perform survey and construction work flows.

The Topcon Receiver Utility (TRU) is a hardware configuration software for receivers and peripheral devices. You can install it on
desktop computers and data controllers. This program is provided on the GPS+ Software CD that accompanied your receiver. A
TRU help document is provided on the GR-5 CD.

Topcon’s MAGNET Field™ software for data controllers provides real-time communication, cloud storage, data collection and
exchange, and field solutions, such as topo, staking, roads, calculations, and more. Contact your Topcon dealer for more
information about MAGNET Field and the entire MAGNET Enterprise system.

Pocket-3D is a program that runs on data controllers with Windows CE® and mobile platforms. Pocket-3D simplifies data
collection, allowing you to check cuts and fills, layout points and survey all or part of the job site quickly and efficiently. Contact
your Topcon dealer for more information about Pocket-3D.
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Getting Technical Support

Before contacting a Topcon customer representative about any problems with the receiver, see “Troubleshooting” on page 68
for some solutions that may fix the issue.

Contact your local Topcon dealer or visit the Topcon Total Care Web site (www.TopconTotalCare.com) for technical support.

,@ For quick and effective support, provide a detailed description of the problem.

N

When contacting Topcon for technical assistance, provide the following information for better and faster service:

1. Adescription of the following:
— Field operation that was being performed when the problem occurred
— Details of the unexpected behavior, symptoms, and any error messages that precede or follow the problem
— Problem occurrence frequency or patterns

2. Receiver information and configuration settings. For receiver information, click Information in TRU, select Save to
File, enter a file name, and save it to the computer.

3. Specifications of mobile devices and computers used in the field or office exhibiting the problem. These
specifications should include model information, version number, operating system information, memory and
storage capacity, etc.

Information about the system software, including the version number and steps to reproduce the problem.

5. A description of the field environment and/or observation conditions when the problem occurred.

Getting Technical Support P/N: 7010-1004
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Website

The Topcon website provides current information about Topcon’s line of products. The support area of the website provides
access to Topcon field and office software, manuals, frequently asked questions, and so forth. To access the Topcon website,

visit www.topconpositioning.com.
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The Topcon’s TotalCare web site also provides complete support, such as news, updates, reminders, training, live Webinars, and
customer service to help you get the information you need. Visit www.topcontotalcare.com.
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Getting Acquainted

The GR-5 receiver enclosure is fully sealed and incorporates the GNSS receiver board, antenna, batteries, memory storage,
and wireless communication device.

Receiver Overview

The upper portion of the receiver contains the GNSS antenna, which is enclosed by the radome and securely surrounded by
a shock-absorbing rubber bumper. The receiver’s magnesium alloy lower enclosure features an easy-to-operate display
panel, detachable batteries, quick release mounting socket, and data ports.

The GR-5 receiver has a highly-visible display panel with single-button operation. The display panel enables you to view the
receiver’s operational status. For more information, see “Display Panel Operations” on page 19.

You can locate regulatory and product identification information on the two receiver labels, which are located inside of the
battery compartments. The product identification label contains the serial number and part number.

Getting Acquainted P/N: 7010-1004 8



Cables

The GR-5 package includes a power supply cable, a USB cable, and a power adapter. Table 1 describes the cables included
with your receiver.

,@ Align the keyways when connecting the power/serial cable to the receiver port. Turn the cable lock clockwise
@ until it clicks to secure the cable in place. To disconnect the cable, turn the lock counter-clockwise, and then
gently remove the cable.
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Table 1. Receiver Cables

Cable Description Cable lllustration

Power Cable

Connects the power supply unit to a grounded outlet.
U.S.: p/n: 14-008052-01

Eur: p/n: 14-008054-01

Aus.: p/n: 14-008053-01
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Cables

Table 1. Receiver Cables

Cable Description

Cable lllustration

USB Cable

Connects the receiver to an external device (controller or
computer) for data transfer and receiver configuration.

p/n 14-008070-01

Receiver Power/Charging Cable

Connects the receiver and the power supply unit via SAE
connectors for battery charging.

p/n 14-008016-03

Serial Cable

Connects the receiver to an external device (controller or
computer) for data transfer and receiver configuration.

p/n: 14-008005-02

P/N: 7010-1004
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Accessories

Topcon offers a wide variety of accessories specially designed to improve system flexibility and job site efficiency. For more
details about the available accessories, contact your Topcon dealer.

® Power Supply Unit (p/n 22-034101-01): charges the detachable batteries when connected to a grounded outlet. This
unit converts the alternating current (AC) normally supplied from an electrical outlet to a direct current (DC) used to
charge the batteries and/or power the receiver.

The power supply unit should only be used for charging the batteries. Do not use as a power source
during surveying.
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The power supply unit can either be connected to the charging cradle or directly to the receiver. For details, see the
power related sections in “Power Supply Unit” on page 33.

® The Modem Antenna: Spread Spectrum or UHF antenna includes support for a GSM/HSPA modem.
The Spread Spectrum antenna is a reverse polarity TNC RF connection (p/n 30-030012-01) and a UHF antenna is a BNC
connection (p/n 30-070003-01 UHF 410-440 or p/n 30-050503-01 UHF 450-470).

® The 2m Fixed Height Tripod and Pole: A heavy duty tripod (22-050501-01).

* The universal tribrach and tribrach adapter! (p/n 22-006008-01 and p/n 22-006009-011): are used to level the tripod
and secure the receiver or antenna to the tripod.

The precision tribrach adapter: is used to precisely center, align, and level the tripod over a point. The horizontal spacer
(p/n 60419) inserts into the precision tribrach and allows the receiver to sit securely on the precision tribrach.

1. The universal tribrach and tribrach adapter is not needed when using the heavy duty tripod (22-050501-01).

Accessories P/N: 7010-1004 11




® The quick disconnect adapter (p/n 02-850905-01): connects to the range pole for the receiver to slip into the top. Using
the side clips, the receiver can be quickly connected to/disconnected from the range pole.

® A hand-held controller: allows the GR-5 Base and Rover systems to be configured and monitored directly in the field.
You can use the Topcon Receiver Utility (TRU) to configure the receiver and any Topcon field data collection software.

® MAGNET and Pocket 3D Software: can be used to operate the receiver. See reference manual of TRU or Field data
collection software for details on set up and operation.

® The ODU-to-alligator clips cable (p/n 14-008097-01LF): connects the charging cradle or receiver to an auxiliary battery
for powering the receiver during survey operations.

® The AA battery pack: holds four AA batteries to provide a portable backup power source for the receiver. Due to
variances in AA battery capacity, and the mode of the receiver and type of modem, the amount of time the receiver is
powered varies. See “Assembling the AA Battery Shell” on page 12 for details on how to attach the pack to the GR-5.

Do not use rechargeable AA batteries.
Do not use the AA battery shell when the radio modem is in transmitter mode.

® (Cradle-to-receiver charging cable (p/n 14-008072-01 (1.5m long) p/n 14-008072-02 (0.5 m long): Connects the receiver
to the charging cradle for external power.
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® Battery Recharger (01-050911-01): Charges the batteries. See “Charging the Batteries” on page 5.
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Batteries 0
=
The receiver comes equipped with two detachable, rechargeable batteries for powering the receiver. For more 35
information about using the batteries, see “Managing Power” on page 30. 0)0]
>
Detachable B
Batte
v =
=
3
~+
(]
(el
Detachable
Battery

Figure 4: GR-5 Detachable Batteries
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Data and Power Ports 0
=
The GR-5 has the following three ports: = 35
® USB-rimmed in yellow; used for high-speed data 09
transfer and communication between the receiver >
and an external device. The body of the connector . > © B
on the corresponding cable is yellow. UI?B if"all(l P°"Le’ = c
® Serial Port A- rimmed in black; used for (ve ‘ow) (black) (r? ) gy > o
communication between the receiver and an 2
external device. (]
® Serial Port B — used internally and left free in the a
current release.
® Serial Port C — used internally to connect the
modem and receiver boards.
® Serial Port D — used internally to connect the | I
receiver board and Bluetooth module. (T =)

® Power - rimmed in red; used to connect the
receiver to an external power source. This port can
also be used to charge the batteries. The body of
the connector on the corresponding cable is red.
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External Radio Antenna Connector

The radio antenna connects to the external antenna connector on the GR-5 radome (Figure 5). The radio antenna uses a
reverse polarity TNC connection or BNC connection depending on the installed radio modem.
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External
Antenna
Connector

Figure 5: GR-5 Radome and External Antenna Connector
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Bottom Connector

The bottom connector (Figure 6) connects the receiver to either a standard 5/8" thread pole/adapter or the quick
disconnect. The quick disconnect adapter (p/n: 02-850905-017?7?) connects to the range pole for the receiver to
slip into the top. Using the side clips, the receiver can be quickly connected to/disconnected from the range

pole.

Quick Disconnect
Adapter

pajuienboy Summen

Bottom Connector
for Standard Setups

Figure 6: GR-5 Quick Connector
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SD/SDHC and SIM Card Slots

The SD/SDHC and SIM card slots are located under the battery compartments near the base of the dome. For more
information about the SD/SDHC card, see “Memory” on page 61. For more information about SIM cards, see “SIM Card
Slot” on page 18.
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Memory Card

Slot is Here SIM Card Slot
is Here

Figure 7: GR-5 Card Slots
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SIM Card Slot

The SIM card slot is located to the right of the LED Display Panel inside the battery compartment. It enables you to install
a standard SIM card into the receiver. Once installed, the SIM card provides a unique identification for the receiver’s
GSM/CDMA module and enables the receiver’s GSM/CDMA functionality based on the subscribed services (the receiver
board accesses the GSM/CDMA module, which accesses the SIM card). The SIM card usually remains inside the receiver.
You can access the GSM/CDMA module, with the SIM card installed, via TRU for configuration purposes. A SIM card can
be purchased from a local cellular provider.

Recommended SIM Cards
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The SIM card must support Circuit Switched Data to communicate directly between receivers. The SIM card must have
GPRS support to communicate over a TCP/IP network.

-~ Both the Base and Rover receivers must have a SIM card installed (supporting Circuit Switched Data) and have
5 subscriptions to the same service provider for proper communication.

Installing the SIM Card

1. Make sure the receiver is turned off.
2. Remove the detachable battery to the right of the LED Display panel.

3. Carefully insert the SIM card, label-side up, into the SIM card slot located at the top of the battery compartment.
Once the receiver is turned on, the receiver board will detect the SIM card, and it will be ready to use as needed.
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Display Panel Operations

The LED display panel (Figure 8) enables you to control receiver power and data recording. The LEDs display the status of
the satellite tracking, recording/memory capacity, Bluetooth connections, and batteries. This chapter describes the different

LED blink patterns and what they mean.

REC RX TX
STAT -\ -\ /- BT

0 0

FUNCTION

[

Battery

Power FUNCTION
Button Button

Figure 8: LED Display Panel
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Power Button

The power button turns the receiver on and off. When turning the receiver on, press the Power button until the LEDs
briefly flash. When turning off the receiver, press the Power button until the LEDs go out.

Press the power
button for about 1
second to turn the

receiver on/off.
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Figure 9: Power Button Functions
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FUNCTION Button/Logging Data

This button switches the receiver between information modes and post-processing modes, starts/stops data recording,
and changes the baud rate of the serial port to 9600. The FUNCTION button enables you to turn data recording on or off.

See Table 2 to learn how to use the FUNCTION button.

Each time data recording is turned off or on, either a new file opens or data appends to a particular file.

Press the FUNCTION
button for 1-5
seconds to start/stop
data logging.

9
(%2}
=
Q
<
o
Q
=)
®
®)
B°)
)
=i
Q
=
o
)
")}

K

0 0]

FUNCTION

FUNCTION
Button

Figure 10: FUNCTION Button
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Table 2. FUNCTION Button Operations and REC LED Status

FUNCTION Key REC LED Status

When data recording is off, and the FUNCTION key is...

No light No data recording.
Orange blink Internal file system test in progress.
Not pressed
Red No free memory; hardware problem with data recording.
No SDHC card.
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If FUNCTION key mode is “LED blink mode switch”

Orange Release to change information mode.
Pressed for < 1
second If FUNCTION key mode is “Occupation mode switch”

Orange No function.

If FUNCTION key mode is “LED blink mode switch”

Green Release to start data recording (post-processing occupation

Pressed for 1-5 mode undefined).

seconds

If FUNCTION key mode is “Occupation mode switch”

Green Release to start recording (Kinematic or Static post-
processing occupation mode).
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Table 2. FUNCTION Button Operations and REC LED Status (Continued)

FUNCTION Key REC LED Status
Pressed for 5-8 Red Release to turn serial port A baud rate to 9600 bps.
seconds
Pressed for > 8 No light No function.
seconds
When data recording is on, and the FUNCTION key is...

Not pressed

Red

No free memory; hardware problem with data recording.

If FUNCTION key mod

e is “LED blink mode switch”

Green

Data recording started (post-processing occupation mode
undefined).

If FUNCTION key mod

e is “Occupation mode switch”

Green Data recording started (Kinematic post-processing
occupation mode).
Orange Data recording started (Static post-processing occupation

mode).

FUNCTION Button/Logging Data

P/N: 7010-1004
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Table 2. FUNCTION Button Operations and REC LED Status (Continued)

FUNCTION Key REC LED Status

If FUNCTION key mode is “LED blink mode switch”

Orange Release to change information mode.
Pressed for < 1
second If FUNCTION key mode is “Occupation mode switch”
Orange Release to toggle between Static and Kinematic post-

processing modes.
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Pressed for 1-5 No light Release to stop data recording.

seconds

Pressed for 5-8 Red Release to turn serial port A baud rate to 9600 bps.
seconds

Pressed for > 8 No light No function (data recording still on).

seconds
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Battery LED

The Battery LED indicates the remaining charge of each detachable battery. When an external power source is utilized,
the LED turns green and begins to blink if the batteries begin to charge. See Table 3 for more information.

Table 3. Battery LED Patterns

LED Color ‘ Description
THE RECEIVER IS ON; DETACHABLE BATTERIES IN USE

The charge is greater than 85 percent.

The charge is intermediate.

The charge is less than 15 percent.
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THE RECEIVER IS ON; EXTERNAL POWER IN USE

An external power source is in use, and the internal batteries are fully charged.

The internal batteries are at greater than 50% capacity; the batteries are being charged.

The internal batteries are at greater than 15% capacity; the batteries are being charged.

The internal batteries are at less than 15% capacity; the batteries are being charged.

THE RECEIVER IS OFF

The receiver is connected to an external power source, and the batteries are fully charged.

0 0] [9]0/0/0 000

The receiver is connected to an external power source, and the batteries are being charged.
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Receiver Status LEDs

There are four status LEDs to provide you information about the battery life, tracked satellites, memory capacity, and
Bluetooth wireless connectivity. This section describes the color and behavior of each LED.

RX TX LED

This LED displays the status of the modem. Table 4 describes the LED colors and patterns for the different modems
available for the GR-5 receiver.

Table 4. RX TX LEDs

FH915/Digital Il
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No Light Modem is turned Off
Green Flashes (green LED, off, green LED) Modem is in receiver mode
Solid Green A radio link has been established; modem is ready to receive data

Solid Green plus yellow (green LED, green LED + red . . . .
Modem is receiving data (Yellow during actual reception)

LED)

Solid Red Modem is in transmitter mode

Red Flashes (rapid red LED, off, red LED) A fault condition has been detected
Red then Green (Red LED, off, green LED, off) Modem is in command mode
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Table 4. RX TX LEDs

Satel Transceiver

Green Flashes (green LED, off, green LED)

Modem is ready to receive data (FCS OFF or RX Slave)

Green with Yellow (green LED, green LED + red LED)

Modem is receiving data (Yellow during actual reception)

Solid red

Tx Master

Green with Red (green LED, red LED)

FCS OFF, transmitting data. (Red during actual transmit)

Yellow flashes (green + red LED, off)

Reception is disabled, either by sending SL+++ or using command
Terminal

GSM/HSPA

Solid Yellow (Red LED + Green LED)

Modem is initializing

Green Flashes

The modem is on, registered on the network, and is waiting for
incoming calls

Solid Red

A connection had been established

Solid Yellow (Red LED + Green LED) (Satel) Green
Blinks (DUHF Il or SpSp)

The modem is in direct control mode (Daisy Chain)

Yellow flashes (green LED + red LED, off)

an error has occurred (initialization error, wrong PIN code etc.)

Receiver Status LEDs

P/N: 7010-1004
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STAT LED

The tracking status LED displays how many satellites the receiver is tracking.
Table 3. Status LED Patterns

LED Color Description

One blink per tracked GPS satellite.

One blink per tracked GLONASS satellite.

One blink when there are no tracked
satellites or solutions. It is Off otherwise.

b0

REC LED

The recording LED indicates if data is being written to memory and displays how much memory the receiver has available
for recording. For a description of the REC LED status when using the FUNCTION button, see Table 2.

Receiver Status LEDs P/N: 7010-1004
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Table 4. Recording LED Patterns

Display Description

o> Green Blink: File logging is in progress. Each blink
indicates data is being written to the SDHC card.

Solid Orange: The receiver is changing modes.
Orange Blink: The file system is not accessible.

Solid Red: A fault condition with the receiver (no
<P more memory, no SDHC card inserted, a
hardware problem, or an improper OAF.

Bluetooth LED
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The Bluetooth LED displays the status of the Bluetooth activity. Table 5 describes the activity.
Table 5. Bluetooth LED Patterns

LED Color Description

Blue Blink: Bluetooth is on and waiting for a connection.

Blue Solid: A single Bluetooth connection is established.

No light: Bluetooth is turned off.

0100
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Managing Power

This chapter describes how to power the receiver, charge the detachable batteries, and use an external power source.

Turning On/Off the Receiver

To turn on the receiver, press and hold the power button until the LEDs briefly flash. When the receiver is turned on, the
receiver’s channels initialize and begin tracking all visible satellites at any time and location.

To turn off the receiver, press and hold the power button for more than three and less than 10 seconds (release the power
button when the BATT LED blinks solid red). This delay prevents the receiver from being turned off by mistake.

placed in storage for a long period, such as a few months, the batteries may become fully discharged. You will

The receiver will draw a small amount of power from the batteries when it is turned off. If the receiver is
need to use an external power supply or recharge the batteries before use.

Powering the Receiver

The receiver is powered by the detachable, rechargeable batteries or an external power source connected to the power
port. If an external power source is connected, the receiver draws power from it over the battery. When the detachable
batteries are depleted, and there is no valid external power source connected or if the source has discharged lower than 9V,

the receiver will draw its power from two internal batteries (non-removable). Depending on the use case, the hours of
operation provided by the internal batteries vary.
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Detachable External Batteries

The receiver first draws power from one battery at a time before switching to the second battery. Each detachable battery
provides between 5 and 10 hours of operation, depending on the receiver mode. For more information, see Table 6.

To check the status of the detachable batteries, view the BATT LED or check the status using available Topcon software.
Check the BATT LEDs for battery status:

® Agreen light indicates a charge greater than 85%.
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® Anorange light indicates an intermediate charge.
® Ared light indicates a charge of less than 15%. Recharge or replace the battery as soon as possible.

Table 6. Estimated Operating Times Using Two Fully-charged Batteries

Common Conditions: Bluetooth = on; 10-12 SV tracked; using the detachable batteries; room temperature

For the GR-5 with FH915+ Modem

Receive only mode 14 hours
250mW transmission mode 12 hours?
IW transmission mode 10 hours®
GSM/HSPA in urban areas 13 hours
For the GR-5 with Digital UHFIl Modem

Receive only mode 14 hours
0.5W transmission mode 12 hours?
1W transmission mode 9 hours?
GSM/HSPA in urban areas 12 hours
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Table 6. Estimated Operating Times Using Two Fully-charged Batteries

For the GR-5 with Satel Modem

Common Conditions: 10-12 SV tracked; using the detachable batteries; room temperature

Q
-]
Receive only mode 14 hours OQQ)
0.5W transmission mode 12 hours?® 5
1W transmission mode 11 hours? O_QU
GSM/HSPA in urban areas 12 hours g
0}
=

For the GR-5 with Any Modem

Modem off | 20 hours

Common Conditions: 10-12 SV tracked; using the battery shells and AA batteries; room temperature

For the GR-5 with Any Modem

Modem off | 2.5 hours

a. At 1 Hz correction rate, charger off.

Charging the Batteries

The batteries are shipped from the factory without power. Fully charge the batteries before surveying. You can use the
power supply unit or the battery charging cradle to charge the batteries.
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Power Supply Unit

The power supply unit (p/n 22-034101-01) charges the external batteries when connected to a grounded outlet. This unit
converts the alternating current (AC) normally supplied from an electrical outlet to a direct current (DC) used to charge
the batteries and/or power the receiver.

Do not expose the power supply to rain or snow. It should only be used for charging the batteries.

The power supply unit is designed for indoor use only. Do not use in a damp or a wet environment.
' Do not use as a power source during surveying.
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You can connect the power supply unit to the charging cradle or directly to the receiver. See “Power Supply Unit” on
page 34. The power supply has the following specifications:

® input voltage — between 100 and 240 V AC
® frequency of input power — between 50 Hz and 60 Hz
® output voltage —12 VDC@2.5 A (30 W)

Powering the Receiver P/N: 7010-1004 33




1lamod SuiSeueypy

To Receiver

Figure 11: Power Supply Unit

Battery Charging Cradle
The battery charging cradle (Figure 12) connects to a standard power outlet using the power adapter cable and power

cable/power supply unit.
The charger has two ports, one button, and three LEDs.

® The two ports connect the charger to either a receiver or an external power source. The ports charge or drain the
batteries simultaneously.
34
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® The STATUS button activates the battery LEDs.
Press STATUS to display the amount of charge for the corresponding battery.

® The two battery LEDs display the percentage of charge in the attached battery:
— A green light indicates a charge greater than 85%.
— An orange light indicates an intermediate charge.
— A red light indicates a charge of less than 15%. Recharge or replace the battery as soon as possible.

® The power LED lights up when the charger is connected to an external power source; such as an electrical outlet or
another power source (12 volt battery).
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Two power in/out ports

STATUS = =
Battery Button Battery . «%TC@R -
| | e
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@ STATUS @ n A A A oA
)
Power

Figure 12: Battery Charger Cradle with Batteries
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You can also attach the battery charger to a tripod, a belt, or an RTK pole to provide external power to the base station or
rover.

Before using the GR-5, fully charge the batteries for maximum operating time.

Charging Temperatures

Charge the batteries only in temperatures between 32°F (0°C) and 113°F (45°C).
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An optimal charging temperature is between 50°F (10°C) and 77°F (25°C). If possible, charge the
batteries within this temperature range.

Charging Procedure

There are two ways to charge the receiver’s detachable batteries:

® while they are attached to the receiver
® while they are attached to the charging cradle

If the batteries are attached to the receiver or to the charging cradle, in approximately six hours the batteries will be
simultaneously fully charged.

The Li-lon batteries used in the battery packs should run at no less than 80% capacity after 500 charging cycles. You do
not need to drain these batteries before recharging.

To charge the batteries using the power supply unit:
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1. Plugthe receiver-to-SAE power cable into the
receiver’s power input port.

2. Connect the receiver-to-SAE power cable and the
power supply-to-outlet cable to the AC adapter.

3. Plug the power supply-to-outlet cable into an
available outlet. The batteries are fully charged
after approximately 6 hours.

To charge the batteries using the charging cradle:

1lamod SuiSeueypy

1. Remove the batteries from the receiver and insert
them into the charging cradle.

2. Connect the power cable to the power supply unit.

3. Connect the SAE connectors on the power adapter
cable and power supply unit.

4. Connect the power adapter cable to one of the
ports on the charging cradle (either port will charge
both/either battery).

5. Plug the power supply to an available outlet. The
batteries are fully charged after approximately 6 hours.

Leaving the Batteries on Charge

The batteries can be safely left in the receiver or the charging cradle once charging is complete. Doing so will not
overcharge or damage the batteries.
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The batteries can also be attached/detached to/from the receiver or charging cradle at any time without harming the
batteries, the receiver, or the cradle. When returning the batteries to the receiver or cradle, charging is automatically

resumed.

Attaching the Batteries

To attach the batteries to the GR-5 (Figure 13):

1. With the battery slightly tipped, place the bottom of the battery into the bottom of the battery compartment.
2. Gently push the top of the battery into the battery compartment until it snaps into place. Make sure that the clip at
the top of the battery completely snaps into place.
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Figure 13: Inserting the GR-5 Batteries
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Detaching the Batteries
To detach the batteries from the GR-5, so that they can be charged or replaced:
Using the clip at the top of the battery, gently pull down and out to detach the battery from the receiver (Figure 14).
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Figure 14: Detach the GR-5 Batteries

Assembling the AA Battery Shell
To assemble the AA battery shell to the GR-5 (Figure 15):

Do not use rechargeable AA batteries.
Do not use the AA battery shell when the radio modem is in transmitter mode.

1. Slide the back cover of the AA battery shell down and lift off.
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2. Insert four AA batteries as shown on the inside of the shell (and in Figure 15 below).
® The batteries on the left lay with the positive end towards the bottom of the shell.
® The batteries on the right lay with the positive end towards the top of the shell.

3. Replace the back cover of the shell.
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Figure 15: Remove Cover and Insert AA Batteries

4. Insert the AA battery shell into the battery compartment of the receiver as shown in Figure 13 on page 4-38.

Surveying While Charging
The user can execute any kind of surveying while charging the internal batteries attached to the GR-5 without degradation
of performance.

While charging, make sure the air temperature is between +32 °F (0 °C) and +113 °F (+45 °C). This is
important to prevent serious damage to the batteries, the receiver or injury to persons.
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Changing the Batteries while Surveying

It is safe to change a depleted battery with a fully charged one while surveying (i.e., on the fly) without turning off the
receiver. Before doing this, make sure the other battery has enough charge to power the receiver while changing the
depleted battery. The surveying will not be disrupted. If needed, repeat this procedure for the second battery.

Using an Auxiliary Power Source
In addition to the detachable batteries, you can connect the receiver to an external power source, such as a vehicle battery

with 9 to 21 VDC, to operate the receiver and for continuous use of the receiver if the detachable batteries become
discharged.

' Power input greater than 21 VDC could damage the receiver.

To connect the receiver to an auxiliary battery (Figure 16 on page 4-42):
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Use the ODU-to-alligator clips cable (p/n 14-008097-01LF) to directly connect the auxiliary battery and the receiver’s
power port (without SAE).

When powering the receiver using external batteries, set the charger mode to Off; otherwise, the
detachable batteries will also charge, causing operation time to decrease.

1. Connect the ODU-to-alligator clips cable to a 12-volt battery.
2. Connect the ODU-to-alligator clips cable to the receiver’s power port.
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3.  Turn on the receiver.

From receiver to
auxiliary battery
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alligator clips
cable.
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Figure 16: Connect an Auxiliary Battery and the Receiver

Assingle external 12V, 2.3 A*h battery should run the receiver and modem for about 9 hours and the receiver for 13 hours.
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To connect the receiver to the charging cradle (Figure 17):

The charging cradle with extra batteries hooks onto a tripod or belt for a convenient power supply for the receiver. The
part number for the receiver-to-charger cradle cable is 14-008072-01 or 14-008072-02.

1. Connect one end of the cradle-to-receiver cable to the charging cradle.

2. Connect the other end to the power port on the receiver.

Connecting the charging

cradle and the receiver using the
cradle-to-receiver charging cable
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Figure 17: Connect the Charging Cradle and Receiver
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Insufficient Power

If the batteries become fully discharged and an external power supply is not connected, the receiver will shut down and
automatically save recorded files. To avoid disruptions, check the BAT LED on the display panel for the battery charge
status. See “Battery LED” on page 25 for more information.

If the receiver shuts down due to insufficient power, the receiver and all communication ports become de-activated.

To restore power to your receiver and turn it back on, do one or all of the following:
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® Recharge the batteries.
® Make sure the power cable is correctly connected to the receiver’s port.
a. Align the keyways when connecting the power/serial cable to the receiver port.

b. Turn the cable lock clockwise until it clicks to secure the cable in place.
c. To disconnect the cable, turn the lock counter-clockwise, and then gently remove the cable.
® Connect the receiver to a different power source.

-~ Power supplied to the receiver should match the specifications provided by Topcon on the product. Failure to
= comply with these specifications may damage the receiver. See “Specifications” on page 78.
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Configuring the Receiver

The sections in this chapter describe receiver options, and how to load a new Option Authorization File (OAF), update firmware,
and perform a factory reset. To do this, you will need to use the Topcon Receiver Utility (TRU) software that was supplied on the
GR-5 CD. For information about installing the software, see the Topcon Receiver Utility (TRU) Reference Manual.

Viewing Receiver Information

In the Topcon Receiver Utility (TRU), the Receiver Info window displays basic receiver information, such as hardware and firmware
versions, RAM size, receiver ID, serial number, etc.

To open the Receiver Info window:

Connect the receiver to a computer and open TRU.

In TRU, connect to the receiver.

Click Device » Application Mode » Receiver Managing.

Click Device » Connect.

In the Connection Parameters window, select the correct serial port, and click Connect.

SN e

In the TRU main window, click the Information icon. The Receiver Info window (Figure 6) appears.
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i Id 001LZUNZQLE 5 -
@ Serial Number GR-5 x000000x 0
@ Board Version BX10
¥ Firmware Version 4,0V Jun,29,2012 b6 ~+
@ Hardware Version 205 = J
¥ Vendor Topcon M
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WERAM Size, KB 16,334 A
()
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Refresh @ | Save toFile

Figure 6: TRU — Receiver Info
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Loading New Firmware

Receiver board firmware is released as a compressed file that you download and decompress. This file contains the following
two files:

® ramimage.ldr — the Receiver board RAM file
® main.ldp — the Receiver board Flash file

To upload firmware files to the receiver:

1. Connect the receiver to a computer using the Power and Serial cable receiver accessory (p/n: 100182-01).

to upload firmware could damage the receiver. The next firmware release, 4.0 SR, will support USB or

' Only use the Power and Serial cable to upload firmware to the receiver. Using a USB or Bluetooth connection
Bluetooth connections for firmware uploads. See www.topcontotalcare.com for firmware updates.

2. To connect to the receiver in TRU:
Click Device » Application Mode » Receiver Managing.
b. Click Device » Connect.

c. Inthe Connection Parameters window (Figure 7), select Serial Port and the port name, and then click
Connect.
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Figure 7: Connection Parameters Window

3. Click the Firmware Z icon in the TRU main window. The Upload Firmware window (Figure 8) displays. This
window enables you to upload firmware files to the connected receiver.

Make sure Receiver is selected in the Device field.

(Recommended) Select Soft Break as the Capture Method.

Browse for and select the receiver board’s RAM and Flash files (Figure 8).

o v
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Figure 8: Upload Firmware Window

7. Click Start to upload the selected files.
8. Click OK to continue uploading new firmware to the receiver (see Figure 9).
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Figure 9: Finishing Firmware Upload

About the OAF

Topcon issues an Option Authorization File (OAF) to enable the specific options that you purchased. Topcon’s OAF system allows
you to customize and configure the receiver according to your particular needs, therefore purchasing only the options you
require.

The GR-5 receiver typically ships with an OAF as per initial purchase of the receiver kit configuration. There are several upgrade
options available with the receiver that can extend the receiver’s functionality to better suit your job requirement. Examples of
upgrade options are listed below:
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Contact your Topcon dealer or a representative for a complete listing of available options and pricing information.
Checking the Receiver’'s OAF

To use TRU to view the status of the receiver’s options:

1. Connect the receiver to a computer and open TRU. See the Topcon Receiver Utility (TRU) Reference Manual for
more information about connecting the receiver to a computer.

2. InTRU, connect to the receiver.

3. Click the Options icon in the main window. The Receiver Options window (Figure 10) displays, so you can view
the current authorization options and upload new ones.

About the OAF

GPS + GLONASS dual frequency static operation
LongLINK base and rover RTK operation
Network RTK operation

RTK and update rate at 20 Hz
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Receiver Options EIEE 3
Option Name Current [ Purchased | Leased | Exp. Date | - =
GPs Yes Yes Yes 5j24/2011 (00}
Glonass Yes Yes Yes 9/24/2011 5‘ C
L1 Yes Yes Yes 9/24/2011 -
L2 Yes Mo Yes 12/31/2011 o
Cinderella Yes Yes Yes 9/24/2011 :
Position Update Rate, Hz 100 20 100 12f31/2011 (0)0]
Raw Data Update Rate, Hz 100 20 100 12/31/2011 -
Code Differential Base Yes Mo Yes 9/24/2011 :
Code Differential Rover Yes MNo Yes 9/24/2011
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Figure 10: Receiver Options

Loading an OAF

Topcon dealers provide customers with OAF files. For any OAF related questions, e-mail Topcon at options@topcon.com and
include the receiver’s ID and serial number. To obtain these numbers, see “Viewing Receiver Information” on page 45.

To load a new OAF:

1. Follow the steps in “Checking the Receiver’s OAF” on page 51.
2. Click Upload OAF on the bottom of the Receiver Options window (see Figure 10).
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3.

About the OAF

Navigate to the location of the new Option Authorization File (Figure 11).

| ——
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m'vw + Computer » 05 (C)) » GRS ~ [ %] [ Search 2]
Organize v New folder =~ 0 @
| GNSS Intemet Radio =] MName ‘ o
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L] SLiss [ _UNIVERSAL_tpo 5
L MAGMET
"1\ Mission Planning Tool
| ModemTPS
| NMEA Reader
'\ NTRIP Client
M pc-cou
'\ Pocket3D
.H Quality Center
|l RegPro
W reio R C P——] '
File name: _UNIVERSAL .tpo ~ | Options Files (*.tpo) -
—
Cor=_1D
e

Figure 11: Load OAF

Select the appropriate file, and click Open (Figure 11).
Topcon’s TRU initially checks to see if the selected file is compatible with the currently connected receiver. If you

chose afile not intended for this receiver, the Upload OAF window displays an error icon next to the Receiver ID and

disables the Upload the File to the Receiver button.
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Figure 12: OAF Compatibility Check

5. Press Upload the File to the Receiver (Figure 12) to start loading the file.
If an OAF file is uploaded to the receiver, TRU will offer to reset the receiver to put new authorization options into
operation (Figure 13).

TR ==

@ The changes will take effect after reset. Reset the receiver?

Figure 13: Reset the Receiver

6. Click Yes.
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Clearing the NVRAM

Juo>

The receiver’s Non-Volatile Random Access Memory (NVRAM) holds data required for satellite tracking, such as ephemeris data
and receiver position. The NVRAM also keeps the current receiver’s settings, such as active antenna input, elevation masks and
recording interval, and information about the receiver’s internal file system. Clearing the receiver’s NVRAM restores the
receiver’s factory default settings.

NS

Although clearing the NVRAM is not recommended as a common practice, there are times when it can eliminate communication
or tracking problems.

¥ 243 8u

After clearing the NVRAM, the receiver requires time to collect new ephemerides and almanacs (around 15 minutes).

Clearing the NVRAM will not delete any files already recorded in the receiver’s memory, and the NVRAM keeps information
about the receiver file system.
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You can also use TRU to clear the NVRAM:

1. Connect the receiver to a computer, and open TRU. See the Topcon Receiver Utility (TRU) Reference Manual for
more information about connecting the receiver to a computer.

2. InTRU, connect to the receiver.
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3. Click the Tools icon @ in the main window.
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The Tools window appears, enabling you to reset the receiver and clear the NVRAM.
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After resetting, the receiver will require some time to re-collect data

needed to track satellites. Continue?
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Figure 14: Tools Dialog Box

4. Click Factory Reset, and click Yes to continue.
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Field System Setup

This chapter describes the field setup of your new receiver, so it is ready for use as a Base, network, RTK Rover, or static data
collector.

Setting Up the Base Receiver

1. Install a heavy-duty tripod (p/n: 22-050501-01) -

over a known point. You do not need a universal I = ] GR-5 Receiver

tribrach and tribrach adapter when working with o B

this tripod. a3 =
2. Attach the antenna to the modem antenna ! |

connector. |

. . Heavy Duty Tripod
3. Level the tripod and tighten the screws. cavy Buly Tripo

Attach any other accessories as needed, such as a
back-up power supply.

5. Measure the height of the receiver from the
ground using the tape measure. See “Measuring g ﬁ J
Antenna Height” on page 59.

6. View the LED display panel for the receiver’s
current status. See also “Display Panel Operations”
on page 19.
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Setting Up the Rover Receiver |
o
1. If needed, attach the quick disconnect to the Q.
bipod/range pole. @
~ GR-5 Recevier !}_
Use a bipod during post-process ‘ ®
~ ’g surveys to ensure the 9 ™ Quick Disconnect (Optional) 3
antenna/receiver does not 5/8 inch Screw (ﬂ/)"
move during data logging. E-
O
2. Attach the receiver to the quick disconnect.
Make sure the receiver locks into place. D Lock
3. If you are not using a fixed height rover pole,
measure the height of the receiver from the T
ground. See “Measuring Antenna Height” on
page 59.

Attach the antenna to the antenna connector.
5. Press the power button to turn on the
receiver. The integrated wireless device in the
receiver turns on when the receiver is
powered. U

6. View the LED display panel for the receiver’s
current status. See also “Display Panel
Operations” on page 19.
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Measuring Antenna Height

The receiver calculates the coordinates of the antenna’s phase center. To determine the coordinates of the station marker,
specify the following:

® Measured height of the antenna above the station marker

® Method of measuring the antenna height

® Model of the antenna/receiver used

Any necessary antenna phase center adjustments, based on the antenna model, is automatically applied. This adjustment, when
combined with accurately measured height and measurement methods, allows for correctly computed reference marker
coordinates.
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To accurately measure the antenna height:

1. Measure the antenna height above the control point or marker, either the slant height or the vertical height.
You may either measure the vertical height to the Antenna Reference Point (ARP) located at the bottom of the
receiver at the base of the mounting threads, or measure the slant height to the Slant Height Measurement Mark
(SHMM) on the side of the receiver. For ARP and SHMM marks on the receiver, see Figure 18.

2. Record the antenna height, points name, and start time in the field notes.

Measuring Antenna Height P/N: 7010-1004 59




B

168mm
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B

A =ARP to edge =79.0
B = ARP to corner = 97.5

% LV = Vertical Length
LS = Slant Length

Figure 18: Antenna Height Measurement Points
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Collecting Data

This chapter provides general information about memory, recording data, downloading data, and removing files to free up memory
space.

Memory

The GR-5 is equipped with an external SD/SDHC memory card slot. Although you may install an SD/SDHC card of any
memory size into the slot, the receiver recognizes only up to 2 GB of memory. The Optional Authorization File (OAF) controls
the receiver’s memory capacity. As data is logged to the card, the REC LED displays the memory capacity status. See “REC
LED” on page 28 for more information. To access the raw data files on the memory cards, see “Managing Files” on page 66.
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SD/SDHC Card

The SDHC card slot is located to the left of the LED Display Panel
inside the battery compartment and connects an optional
SD/SDHC card to the receiver board to provide memory. Once
installed, the SD/SDHC card usually remains inside the receiver.
You can access the data that resides on the SD/SDHC card via the
USB or serial port, or Bluetooth wireless technology (see
“Managing Files” on page 66). A secure digital card can be
purchased at a local computer supply store.

Recommended SD/SDHC Cards

The following cards were tested in the temperature range of -
30°C to 60°C (-22°F to 140°F):

® Transcend® Ultra Industrial 2 GB

® APRO® Industrial 4GB

® SanDisk® Ultra Il

® Swissbit® Industrial 2GB

Use only industrial-grade SD/SDHC cards. Before using any other SD/SDHC cards, consult with Topcon

' Customer Support about compatibility.

Memory

P/N: 7010-1004

Card Slot
(for SDHC card)

62



Installing the SD/SDHC Card

Make sure the receiver is turned off.
Remove the detachable battery to the left of the LED Display panel.
Carefully insert the SD/SDHC card, label-side down, into the card slot located at the top of the battery

compartment.
Once the receiver is turned on, the receiver board will detect the SD/SDHC card, and it will be ready to use as

needed.

is described below.

@@ Always initialize the file system on the installed SD/SDHC card before the first use. The Initialization procedure
=
=

Memory

Initializing the File System

The GR-5 supports a removable SDHC memory card to log raw data files. The memory card must be initialized before its
first use. Initializing the memory card while in the receiver ensures the card is formatted to the TPS proprietary file system
(TPFS). This file system allows the receiver to create, store, retrieve, delete, and restore raw data files.

It is also advisable to re-initialize the memory card periodically (e.g., quarterly). This erases any data on the card, checks
for bad blocks, and sets the card up afresh.

The user can use TRU to initialize the file system.
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Initializing the File System Using TRU

1. Connect the receiver to a computer and run TRU. See “Connecting the Receiver and a Computer” on page 16.

2. Click the File Explorer icon to open the File Explorer screen.

3. Onthe Files tab, press and hold the left mouse button on the file line.

4. Click Initialize File System.
~ Initializing the file system of a connected receiver will erase all of the receiver’s data files. A warning message
= will appear to confirm the operation.

Setting Recording Parameters
The Topcon Receiver Utility (TRU) software enables you to set logging parameters, such as logging rate and types of messages,

in which to record data. This software and the TRU Reference Manual is supplied on the GR-5 CD. See the TRU Reference Manual
for more information. The GR-5 is compatible with any Topcon field software for configuration and recording raw data.

Logging Rates

The amount of memory used to log data depends on the logging rate. For more information about setting logging rate
parameters, see the TRU Reference Manual.
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Recording Data

You can log raw GNSS data to the receiver’s SD/SDHC card and use the Topcon Receiver Utility (TRU) or MAGNET Office™
software to download the files to a computer.

To start or stop recording data, use the LED display panel or TRU:
1. Press the Power button to turn on the receiver.

2. Wait for the STAT LED to indicate satellites are being Press the FUNCTION

tracked. The STAT LED blinks green for GPS satellites and button for 1-5
amber for GLONASS satellites. A short red blink indicates seconds to start/stop
the receiver has not solved a position. Five or more data logging.

satellites provide optimal positioning.

3. To begin recording, press and hold the FUNCTION button,
and then release it (between 1 and 5 seconds) when the

REC (Recording) LED turns green. 0 0
4. Make sure the REC light blinks green. This indicates that a (Foncrion)

file has opened and data collection has started. The REC

LED blinks each time data is saved to the SD/SDHC

memory card. If the REC light blinks red, the receiver has: FUNCTION

® a3 hardware problem Button

® 1o SD/SDHC card installed
® not enough space on the memory card???
® animproper OAF (See “About the OAF” on page 50)
5. You can also select File Explorer » Logs » Start in TRU to begin recording data.
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6. When you have finished recording, press and hold the FUNCTION button until the REC LED turns dark. You can also
select File Explorer » Logs » Stop in TRU to end data recording.
7. To turn off the receiver, press and hold the Power button until all LEDs turn dark.

@@ You can also log data using MAGNET Field software.
=

Managing Files

Raw data is recorded as time-tagged measurements in a single raw data file. Each file is recorded to the receiver’s memory, and
automatically given a name and a *.tps file extension. You can then transfer a file of collected data can to a computer with file
managing software, such as the Topcon Receiver Utility (TRU), which is supplied on the GPS+ CD. These programs allow you to
use an automatic naming feature, enter file names, and delete files as necessary. For more information, see the TRU Reference
Manual supplied on the GR-5 CD.

Downloading and Deleting Files

After completing a survey, download data files to a computer or a controller for storage, post-processing, or backup. The
SD/SDHC cards hold a finite amount of files, so you will want to delete files to increase memory capacity.

When the memory is full, the receiver stops logging data, and the REC LED turns dark/off, indicating an error condition. Existing
data is not overwritten.

There are two options for deleting raw data files from the receiver:
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® Delete all of the files using the LED display panel (i.e. hold the power button for 15 to 20 seconds). This erases all of the
files on the SD/SDHC card.
® Use a USB, serial, or Bluetooth connection to download the files to a computer. In TRU, you can select the files you want
to delete from the receiver. See the TRU Reference Manual for more information.
Once a connection is established, you can download all or some files to a computer or controller and then use the File Explorer
feature in Topcon Receiver Utility (TRU) to manage the raw data files. For more information about using TRU to download or
delete files, see the Topcon Receiver Utility (TRU) Reference Manual included on the GR-5 CD.

eleg 3undajjod
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Troubleshooting

This chapter will help you diagnose and solve some common problems that may occur with the receiver.

Do not attempt to repair equipment yourself. Doing so will void the warranty and may damage the hardware.

Check This First!

Before contacting your local dealer or Topcon Technical Support, check the following:

® Check all external receiver connections carefully to ensure correct and secure connections. Double check for worn or
defective cables.

® Check the receiver’s internal batteries for a full charge.

® Check the power source for incorrectly connected cables, and ensure the power source is valid. See “Specifications” on
page 78 for external power requirements.

® Check the software. Make sure the most current software version is downloaded onto the computer and the most current
firmware is loaded into the receiver. Check the Topcon website for the latest updates.

® Check Topcon Technical Support (www.topconsupport.com) or Topcon Total Care (www.topcontotalcare.com) for the
latest updates.

Then, try the following:

® Power on and off the receiver by pressing the Power button or by using TRU (Tools » Reset receiver).
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® Restore default settings by pressing the Power button for 10 to 15 seconds or using TRU (Tools » Clear NVRAM). This
restores the receiver’s parameters to the factory default settings and erases the almanac and ephemeris files. This
action does not delete data files from the receiver memory.

® Erase all files by pressing the Power button for 15 to 20 seconds or by using File Explorer » Delete All Files in TRU. This
will delete all files stored in the receiver’s non-removable memory card.

If the problem persists, see the following sections for other solutions.
Powering Problems

The following are some of the most commonly encountered power problems.

The receiver does not power up
® The battery may be discharged.
— Charge the battery overnight. See “Charging the Batteries” on page 32.
® |f you are using an external power source, the cable may be disconnected or damaged.
— Make sure the cable is securely connected and undamaged.
® The receiver may have a defective charger or defective battery.

— If, after changing the battery or connecting an external power source, the receiver still does not power up,
contact your local dealer or Topcon Technical Support for advice.
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Receiver Problems

The following are some of the most commonly encountered receiver problems.

The receiver cannot establish a connection to a computer or external controller

Cable specific problems:

® The cable is not properly plugged in.
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— Unplug the cable, then securely and properly reconnect it to the receiver.
® The cable is damaged.

— Use an undamaged cable. Contact a dealer to replace the cable.
® The USB driver is not installed.

— If you are using a USB cable connection, make sure the USB driver, included on the GPS+ Software CD, is
installed on the computer. You can also download the driver from the Topcon support Website at
www.topcontotalcare.com.

Generic problems:

® The receiver port used for connection is not in Command mode.

a. Connect the receiver to a computer and open TRU (see “Connection” in the Topcon Receiver Utility (TRU)
Reference Manual).

b. Click Receiver Settings » Ports.

c. Change the Input Mode for the port used for connection to cmd.
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The receiver does not lock on to satellites for a long period of time

® The corresponding receiver options may be disabled or expired (L1/L2, GPS/GLONASS must be on to track satellites).

— Order a new OAF with the desired options activated to enable or extend validity of the corresponding receiver
options. Contact a dealer or visit the Topcon website for details.

— Refer to the “Receiver Managing” chapter of the Topcon Receiver Utility (TRU) Reference Manual for a detailed
description of options.
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The receiver tracks too few satellites
® The survey is conducted near obstructions (tree canopy, tall buildings, and so forth).
— Make sure the Multipath Reduction boxes have been enabled.

a. Connect the receiver to a computer and open TRU (see “Connection” in the Topcon Receiver Utility (TRU)
Reference Manual).

b. InTRU, connect to the receiver.

c. Onthe TRU main window, choose Receiver Settings » Tracking » Adv tab. Make sure the C/A code
multipath reduction check box is selected.

® Move to an area free of obstructions, if applicable.

The receiver cannot obtain Code Differential and/or RTK solutions
® Incorrect Base coordinates entered.
— Specify the correct coordinates for the Base station using TRU or another suitable field data collection software.
® There could be some obstruction to the connection.
— Clear all possible obstructions or relocate the Base so there is a “line-of-sight” path to the Rover.
® The corresponding receiver options may be disabled or expired.
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— Order a new OAF with the required options activated to enable or extend validity of the corresponding receiver
options.
— Refer to the Topcon Receiver Utility (TRU) Reference Manual for a detailed description of options.

® There are not enough common satellites. In order to obtain a fixed solution, the Base and Rover should track at least
five common satellites.

— Check the elevation masks of the Rover and Base receivers; they should be the same. To do this, on the TRU
main window, choose Receiver Settings » Tracking » Obs.

— Verify there is a clear view of the sky to allow sufficient satellite tracking.

=
=
o
c
=
M
w0
I
o
o
=
=

0Q

® Adiscrepancy exists between the differential standards used at the Base and Rover receivers.
— Ensure the Base and Rover receivers use the same corrections input/output format:

a. Connect the receiver to a computer and open TRU (see “Connection” in the Topcon Receiver Utility (TRU)
Reference Manual).

b. InTRU, connect to the receiver.
c.  Onthe TRU main window, choose Receiver Settings » Ports.
d. Double-click on the port to be configured and make sure the input mode of the Rover matches the format
of the Base output mode (i.e. RTCM3).
® Poor satellite geometry (PDOP/GDOP values are too high).
— Conduct the survey where satellite visibility is better (low PDOP value).
— Ensure the elevation mask is less than 15 degrees.
— Increase the PDOP threshold. To do this, on the TRU main window, choose Receiver Settings » Tracking » Obs.
® The elevation mask is above 15 degrees.
— Lower the elevation mask. To do this, on the TRU main window, choose Receiver Settings » Tracking » Obs.
— Verify there is a clear view of the sky to allow sufficient satellite tracking.
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® The modem battery is low.

The specified baud rate is incompatible with the baud rates the modem supports. The baud rate is the rate at which the
receiver transmits differential messages to the modem and vice versa.

— Change the modem’s baud rate.

The Base and Rover modems use different radio link parameters.
— Configure the Base and Rover radio modems according to the procedures listed in the TRU Reference Manual.
® The distance between the Base and Rover is too far.
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— Close the distance between the Base and Rover.
— Use repeaters to increase radio coverage.
® There may be a source of radio interference that disrupts radio communications.
— Change the RF channel (if possible).
— Removing the source of the jamming signal or relocate the radio antennas (if possible).

The receiver does not start logging data
® The SD/SDHC card is not properly inserted.
® The receiver’s memory is disabled or expired.
— Make sure the memory option is enabled. For details, see the Topcon Receiver Utility (TRU) Reference Manual.
® The memory card does not have free space.
— Download and/or delete data files to free up space for new files. See “Downloading and Deleting Files” on
page 66.
—The file system is not initialized. Initialize the File System on the SD card using TRU. To do this, on the TRU main
window, choose File Explorer P Initialize File System.

Receiver Problems P/N: 7010-1004 73




Bluetooth Problems

The following are some of the most commonly encountered error messages and other problems.

TRU error message: Can’t find receiver

® The receiver is turned off.
— Ensure the receiver has power and is turned on.
® Bluetooth is not turned on; the BT LED is off.
— Reset the receiver to the factory default settings by pressing the Power button for 10 to 15 seconds.
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—You can also turn on power to Bluetooth using TRU. To do this, on the TRU main window, choose Receiver
Settings » Bluetooth.

® Thereis interference.

— Move the receiver, controller, or computer to an unobstructed location.
® The receiver is too far away.

— Move the devices closer together.
® The receiver is already connected via Bluetooth to another device.

— Disconnect the receiver from the other controller or computer.
® The receiver port used for connection is not in Command mode.

a. Connect the receiver to a computer and open TRU (see “Connection” in the Topcon Receiver Utility (TRU)
Reference Manual).

b. Click Configuration » Receiver » Ports.
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c. Change the Input Mode for the Bluetooth serial port used for connection to cmd.
~ This is the most common cause for this error message. Use TRU to double check the settings for the
= connection port.

TRU error message: Open COM# port failed: Access is denied
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® Another application uses the computer port dedicated for connection.
— Close the application, and then re-connect.
— Connect the receiver via another, unused computer port.

After searching for available devices, none are discovered

® The receiver is not receiving power.
— Check that the receiver is getting power and is turned on.
— Check that the power cable is correctly attached to the port if one is being used.
— Unplug the cable, then securely and properly reconnect it to the receiver.
— If the power cable is damaged, contact a Dealer to purchase a new cable.

Can see the icon for the receiver’s Bluetooth module on the computer screen, but cannot connect to it

® Device security settings probably differ.
— Make sure the Bluetooth enabled devices use the same security settings.
® Bluetooth module settings may have changed.
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a. If the settings are changed for the Bluetooth module, remove it from the list of discovered Bluetooth
devices using the Bluetooth manager program (supplied with the device used to manage the receiver).

b. Repeat the search.
TRU Problems

The following is the most commonly encountered TRU problem.
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TRU cannot connect to the receiver
® The receiver is turned off.
— Ensure the receiver has power and is turned on.
® |f using a cable, the cable’s connectors are improperly attached.
— Check that the cable connector is attached to the correct serial port.
— Unplug the cable, then securely and properly reconnect it to the receiver.
® |f using a cable, the cable is damaged.
— Use an undamaged cable.
— Contact a dealer to purchase a new cable.
® |f using Bluetooth wireless technology, the incorrect port is selected.
— Use a computer or receiver that has Bluetooth wireless technology enabled/installed.

— Make sure the computer and receiver use the correct ports for communication. For the GR-5 receiver, this is
Bluetooth serial port A (btsp\a).
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Cleaning and Storing the Receiver

® Use a clean cloth moistened with neutral detergent or water.
® Never use an abrasive cleaner, ether, thinner benzene, or other solvents.
® Always make sure the receiver is completely dry before storing it. Dry any moisture with a soft, clean cloth.

Getting Customer Support
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If the troubleshooting hints and tips in this operator’s manual fail to remedy the problem, contact Topcon Customer Support.
For contact information, see “Getting Technical Support” on page 6.

Cleaning and Storing the Receiver P/N: 7010-1004 77




Specifications

The GR-5 is a Vanguard technology-based GNSS receiver featuring 226 channels and LongLINK wireless technology for small job
site operations and cable-free network solutions. This chapter provides specifications for the receiver and its internal component

General Details

Table 7 lists the receiver’s general specifications.

Table 7. General Receiver Specifications

Physical

Enclosure Magnesium, IPX 6 extrusion, rainproof

Color Topcon Yellow and Gray (bumper)

Dimensions (mm) 158.1 (w) x 253 (h) x 158.1 (d)

Weight 1.88 kg with batteries, 1.44 kg without batteries
Antenna Internal

Battery Two external, detachable

Controller External
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Table 7. General Receiver Specifications

Mounting 5/8-11, quick disconnect
Seals Silicon (molding in color)
Keys Two keys:

¢ Power — On/Off
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¢ Function — start/stop data logging; switch information mode

LEDs Six LEDs:

e STAT —satellite and receiver status

e REC —record and data status

e RXTX—modem status

e BT — Bluetooth wireless technology connection status

e BATT (x2) — battery status

Environment
Operating temperature -40°C to +70°C
-30°C to +60°C with integrated batteries
0°C to +45°C charging mode with batteries
Storage temperature -20°C to +35°C with batteries
-40°C to +75°C without batteries
Humidity 95%, condensing
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Table 7. General Receiver Specifications wn
O
Waterproof rating IPX7 (1 meter submersion) 2
Dust rating IP6X (Fully dust proof) ;—:
Random vibration MIL-STD 202G, Method 214A, Test Curve A, 5.35g RMS %
Sinusoidal vibration SAE J1211:1978 Section 4.7, 4g Peak a
Shock |IEC 60068-2-27 edition 4, Table A.2
25g, 6ms

Topple 2.0m pole drop
Power
External Batteries Li-ion, 3900 mAh, 7.2 V; 2 batteries, detachable
Battery size 133 x 55 x 35 (mm)
Battery weight 220 g (1 battery)
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Table 7. General Receiver Specifications

Operating time e Modem = off —approx. 20 hours

e AA-sized battery shells attached to both battery slots and modem
Average with modem “on” is off —approx. 2.5 hours
and 12 SVs tracked. FH915

’

e Receive-only modem — approx. 14 hours
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Using new batteries,

operating at room
temperature and e Transmitting at 1 W —approx. 10 hours

transmitting at 1 Hz rate. Digital UHF Il

e Transmitting at 250 mW — approx. 12 hours

¢ Receive-only modem — approx. 14 hours
e Transmitting at 250 mW —approx. 12 hours

e Transmitting at 1 W —approx. 10 hours
Satel

e Receive-only modem — approx. 14 hours
e Transmitting at 250 mW — approx. 12 hours
e Transmitting at 1 W — approx. 10 hours

External power 1 port

Input voltage 9 to 21 V DC (for work)
10 to 21V DC (for charge battery)
Maximum Charge Current <=2 Amp
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Table 7. General Receiver Specifications

Consumption e Modem = off —approx. 2.5 W

e Urban areas with short distance to cell sites and GSM/GPRS is on
Average with modem “on” —approx. 4.2 W
and 12 SVs tracked. FH915

e 915 receive-only modem — approx. 3.4 W
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Using new batteries,

operating at room
temperature and e 915 modem transmitting at 1 W — approx. 6 W

transmitting at 1 Hz rate. Digital UHF 1l

¢ 915 modem transmitting at 250 mW — approx. 5.0 W

e Receiver:3.3 W
e Receiver + modem (RX mode): <=4.3 W
e Receiver + modem (TX 0.5 W): <=6 W

e Receiver + modem (TX 1 W): <=7 W
Satel

e Receiver:3.3 W

e Receiver + modem (RX mode): <=4.3 W
e Receiver + modem (TX 0.5 W): <=6 W

e Receiver + modem (TX 1 W): <=7 W

Battery charge Connect the AC adaptor to charge the internal battery.
Available run charge when connected to external battery.

Charging time 6 hours for full charge
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Table 7. General Receiver Specifications

On-board Backup battery for timekeeping and almanac data storage; 10 years
minimum operation

/10

Communication Ports A high-speed RS232 serial port (rimmed in black), a USB port
(rimmed in yellow), and an internal Bluetooth communication port

(port D).
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Port specifications RS232 Serial Port
Baud rate: 460800, 230400, 115200 (default), 57600, 38400,
19200, 9600, 4800, 2400, 1200, 600, 300
Flow control: RTS/CTS
Length: 7,8 (default)
Stop bit: 1 (default), 2
Parity: None (default), Odd, Even
Bluetooth port
Available
USB port
Version 1.1

Connectors Modem Antenna (BNC or reverse polarity TNC depending on
modem type), PWR, RS$232 Serial, USB

MINTER (LED Display) Six external LEDs (see “Display Panel Operations” on page 19 for
details)

ON/OFF control input (power button)

Data logging control (FUNCTION button)
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Table 7. General Receiver Specifications

Data Features

e Up to 100 Hz update rate for real time position and raw data
(code and carrier)

e 10cm code phase and 0.1mm carrier phase precision
e RTCM SC104 version 2.1, 2.2, 2.3,and 3.0 1/0

e Multiple Base RTCM

e Geoid and Magnetic Variation models

o Different DATUMs support

e Qutput of grid coordinates

e CMR and CMR+ support

Technology

e Topcon Vanguard™ ASIC technology

* Fence Antenna™ Technology

e Topcon Advanced Multipath Rejection (AMR)
¢ Integrity Monitoring (RAIM)

e Topcon Automatic File Rotation Mode (AFRM)

e Universal Tracking Channels

NMEA

NMEA version

Ver. 2.1,2.2,2.3, 3.0 output

General Details

P/N: 7010-1004
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Table 7. General Receiver Specifications

2]
O
Messages GGA, GLL, GNS, GRS, GSA, GST, GSV, HDT, RMC, VTG, ZDA, ROT, 2
GMP, UID, P_ATT =
Q)
Output internal 1Hz standard; 5, 10, 20, 50, 100 Hz optional EJF
DGPS o
o)
Correction format RTCM SC104 Ver 2.1,2.2,2.3, and 3.0 2
RTCM message type 1,3,9, 31, 32, 34; user selectable
Process interval 1Hz standard; 5, 10, 20, 50, 100 Hz optional
Output interval for RTCM 1Hz standard; 5, 10, 20, 50, 100 Hz optional
correction data
Elevation mask 0 to 90 degrees (independent of data logging)
Multi-base DGPS Differential correction select mode: Nearest, Mix, Best (optional)
RTK
Correction format CMR2/CMR+ (Trimble compatible), RTCM SC104 Ver 2.2, 2.3, or
3.0
RTCM message type 3,18, 19, 20, 21, 22; user selectable
Ambiguity initialize OTF (L1, L1/L2)
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Table 7. General Receiver Specifications

Baseline Length

Up to 50km in the morning and evening.
Up to 32km at noon.

Initialize time

5 seconds to 10 min depending on the base line length and multipath
conditions

Output interval for
CMR/RTCM

1Hz standard; 5, 10, 20, 50, 100 Hz optional

Elevation

0 to 90 degrees (independent of data logging)

Solution mode

Delay (synchronization)
Extrapolation (not synchronized)

Process interval

1Hz standard; 5, 10, 20, 50, 100 Hz optional

Data Output

RTK Corrections

TPS, RTCM SC104 v 2.x, 3.x; CMR/CMR+?

(max.)

ASCII Output NMEA 0183 version 2.x and 3.x
RTK position data rate (max.) | 20 Hz
Measurement data rate 20 HZ?

Survey Modes

General Details

P/N: 7010-1004
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Table 7. General Receiver Specifications

Base or Rover Static

Kinematic (Stop and Go)
RTK (Real-time Kinematic)
DGPS (Differential GPS)
WASS/EGNOS DGPS
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Survey Accuracy

Static, Fast Static For L1 — H: 3mm + 0.8ppm (x baseline length);
V: 4mm + 1ppm (X baseline length)

For L1+L2 — H: 3mm + 0.5ppm (x baseline length);
V: Smm + 0.5ppm (x baseline length)

Kinematic, RTK For L1 - H: 15mm + 1.5ppm (x baseline length);
V: 30mm + 1.5ppm (x baseline length)

For L1+ L2, L1 — H: 10mm + 1.0ppm (x baseline length);
V: 15mm + 1.0ppm (x baseline length)

DGPS with User Base — H: 0.4m RMS
V: 0.6m RMS
with SBAS — H: 1.0m RMS
V: 1.5m RMS
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Table 7. General Receiver Specifications

Hot Start <= 10 sec
Warm Start <= 30 sec
Cold Start <= 60 sec
Reacquisition <=1 sec

Communication
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Serial 1 port; Hirose H205-Series (6-pin, multiplex); RS232 RX/TX
usB 1 port; USB Mini B 2.0 (client)

Bluetooth v2.1 +EDR

Cellular Yes. Via external Bluetooth-enabled controller or device.

Survey Accuracy®

Static, fast-static (post- L1 only:

processed) H: 3 mm + 0.8 ppm (x baseline distance)
V: 4 mm + 1 ppm (x baseline distance)

L1 +L2:
H: 3 mm + 0.5 ppm (x baseline distance)
V: 5 mm + 0.5 ppm (x baseline distance)

Kinematic, RTK L1 +L2:
H: 10 mm + 1 ppm
V: 15 mm+ 1 ppm
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Table 7. General Receiver Specifications

wn

©

DGPS H:0.4m g
V: 0.6 m =)

)

SBAS H:1.0m E’l-
V:1.5m o

3

(7]

a. CMR/CMR+ is a third-party proprietary format. Use of this format is not recommended and
performance cannot be guaranteed. Use of industry standard RTCM 3.x is always recommended for
optimal performance.

b. 100 Hz operation can be supported for custom applications. For more information, contact your dealer.

c. Accuracy will vary depending on the number of satellites used, obstructions, satellite geometry (PDOP),

occupation time, multipath effects, and atmospheric conditions. Performance may be degraded in
conditions with high lonospheric activity, extreme multipath, or under dense foliage. For maximum
system accuracy, always follow best practices for GNSS data collections.
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GPS Board Details

Table 8. General Receiver Specifications

Receiver Type (set by activating the proper OAF)

Internal board: GPS: L1/L2 C/A & P (Y) -code, L2C, L5 full wave carrier
GR-5 GLONASS: L1, L2 C/A & P-code full-wave carrier
GALILEO: Giove-A, Giove-B (E & E5a)

SBAS (WAAS/EGNOS/MSAS) L1 code & carrier

Hardware type: with FH915+ TX/RX/RP
country/region/purpose with FH915+ TX/RX/RP + GSM/GPRS
dependent with Digital UHF II + GSM/GPRS

with Satel UHF + GSM/GPRS

Receiver Type (set by activating the proper OAF)

Internal board: GPS: L1/L2 C/A & P (Y) -code, L2C, L5 full wave carrier
GR-5 GLONASS: L1, L2 C/A & P-code full-wave carrier
GALILEO: Giove-A, Giove-B (E & E5a)

SBAS (WAAS/EGNOS/MSAS) L1 code & carrier

Tracking

Number of Channels 226 channels Vanguard™ ASIC with patented Universal Tracking
Channel Technology?®

GPS: L1 C/A, L1, L2P(Y), L2, L2C code and carrier
GLONASS: L1 C/A, L1P, L2 C/A, L2P code and carrier

Tracked Signalsb

GPS Board Details P/N: 7010-1004
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Table 8. General Receiver Specifications _%)
SBAS WAAS/EGNOS/MSAS/QZSS) L1 code and carrier o
Multipath reduction Yes, code and carrier ;—:
PLL/DLL setting Adjustable bandwidth and order %
Smoothing interval Adjustable, code and carrier a
Data and Memory
Removable media SDHC (Secure Digital High-Capacity) card, removable
Capacity Depends on the capacity of the installed SDHC card, currently up to

2GB

Message storage rate (max.) | 20 Hz

a. Vanguard ASIC includes two dedicated channels for L-Band signal tracking. The GR-5 receiver does not
support L-Band signal tracking.

b. The GR-5 includes the latest Vanguard ASIC technology, and is capable of supporting planned signals for
both Galileo and COMPASS. Support will be incorporated to GR-5 when these constellations have
matured and are ready for commercial use.

c. Recommended cards: Transcend® Ultra Industrial 2 GB, APRO® Industrial 4GB, SanDisk® Ultra Il, or

Swissbit® Industrial 2GB.

Cinderella days is an option that turns a single frequency, GPS receiver into a dual-frequency, GNSS GLONASS receiver for 24
hours every other Tuesday at GPS midnight. Refer to Topcon’s website for more information and specific Cinderella day dates.
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Bluetooth Module Details

Table 9. Bluetooth Module Specifications

Range up to 10 m (indoor); up to 20 m (outdoor)
Type Class 2
Service classes Miscellaneous

Supported profiles

LM, L2CAP, SDP, SPPP

Frequency Country Code

North America and Europe

Range up to 10 m (indoor); up to 20 m (outdoor)
Type Class 2
Service classes Miscellaneous

Supported profiles

LM, L2CAP, SDP, SPPP

Frequency Country Code

North America and Europe

Range up to 10 m (indoor); up to 20 m (outdoor)
Type Class 2
Service classes Miscellaneous

Supported profiles

LM, L2CAP, SDP, SPPP

Bluetooth Module Details

P/N: 7010-1004
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Table 9. Bluetooth Module Specifications

Frequency Country Code North America and Europe

Range up to 10 m (indoor); up to 20 m (outdoor)
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[[Do you want to list all of the modem specifications?? We can if you want??]]

Connector Specifications

The GR-5 has one antenna connector for radio transmission/reception and three port connectors for power and data
upload/download.

Radio (Modem) RF Connector

The modem connector (Table 9-1) is a reverse polarity TNC connector for spread spectrum and a BNC connector for Digital and

Satel modem.
Table 9-1. Modem Connector Specifications
Modem Type Signal Type Dir Details
Spread Reverse Modem I/O 1/0 RF/GSM
Spectrum polarity TNC input/outputto/from
modem antenna
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Table 9-1. Modem Connector Specifications

%2

O

Modem Type Signal Type Dir Details g
=

Digital/Satel BNC Modem 1/0 I/0 RF/GSM o
input/outputto/from E’F
modem antenna 6

-

(V)]

Power Connector

Rimmed in red, the power connector (Figure 9-1) is a sealed receptacle, 5 pin, ODU part number G80F1C-TO5QF00-0000.

@
®
S

@ ©

Figure 9-1. Power Connector
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Table 9-2 describes power connector specifications.

Table 9-2. Power Connector Specifications

Number Signal Name Dir Details
1 Power_INP 9 to 21 volts DC input
2 Power_INP 9 to 21 volts DC input
3 Power_GND Ground, power return
4 Power_GND Ground, power return
5 Aux_Power 9 to 21 volts DC input

Connector Specifications

P/N: 7010-1004
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Serial C-RS232 Connector

Rimmed in black, the serial RS232 connector (Figure 9-2) is a sealed receptacle, 7 pin, ODU part number G80F1C-T07QC00-0000.
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Figure 9-2. Serial RS232 Connector

Table 9-3 gives the RS232 cable connector specifications.

Table 9-3. RS232 Connector Specifications

Number Signal Name Dir Details
1 Not used
2 GND - Signal ground
3 CTS | Clear to send
4 RTS 0] Request to send

Connector Specifications P/N: 7010-1004 926




Table 9-3. RS232 Connector Specifications (Continued) wn

O

Number Signal Name Dir Details 2
=

5 RXD | Receive data a)
; S
6 TXD 0 Transmit data 6
7 Not used a

USB Connector

Rimmed in yellow, the USB connector is a sealed receptacle, 4 pin TPS cable connector (Figure 9-3).

@ @
® @

Figure 9-3. USB Connector for GGD Options
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Table 9-4 gives the USB connector specifications.

Table 9-4. USB Specifications

Number Signal Name Dir Details
1 USB_PWR P Bus power input
2 USB D- 1/0 Data minus
3 USB D+ 1/0 Data plus
4 GND - Ground

Connector Specifications

P/N: 7010-1004
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Safety Warnings

General Warnings

To comply with RF exposure requirements, maintain at least 25cm between the user and the receiver when
operating LongLINK technology.

TPS receivers are designed for survey and survey related uses (that is, surveying coordinates, distances, angles and
depths, and recording such measurements). This product should never be used:
® Without the user thoroughly understanding this manual.

® After disabling safety systems or altering the product.
® With unauthorized accessories.

® Without proper safeguards at the survey site.

® Contrary to applicable laws, rules, and regulations.
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Battery Warnings

M Aiajes

Never attempt to open the casing of the detachable batteries! Lithium-lon batteries can be dangerous if
mishandled!
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Do not incinerate or heat the battery above 212 degrees fahrenheit (100 degrees celsius). Excessive heat can
cause serious damage and possible explosion.

Tampering with the batteries by end users or non-factory authorized technicians will void the battery’s
warranty.

¢ Do not disassemble the batteries.

¢ Do not charge in conditions different than specified.

e Do not use other than the specified battery charger.

e Do not short circuit.

e Do not crush or modify.
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Receiver Warnings

Tampering with the receiver by the end users or non-factory authorized technicians will void the receiver’s

warranty:
® Do not attempt to open the receiver and modify any of its internal components.

® Do not charge in conditions different than specified.
® Do not short circuit.

Usage Warnings

If this product has been dropped, altered, transported or shipped without proper packaging, or otherwise
treated without care, erroneous measurements may occur.
The owner should periodically test this product to ensure it provides accurate measurements.

Inform TPS immediately if this product does not function properly.

Only allow authorized Topcon warranty service centers to service or repair this product.

Receiver Warnings P/N: 7010-1004

101

M Aiajes

o))
=
2
]
0Q
")




The following sections provide information on this product’s compliance with government regulations for use.
FCC Compliance

This equipment complies with FCC radiation exposure limits set forth for uncontrolled equipment and meets the FCC radio
frequency (RF) Exposure Guidelines in Supplement C to OET65. This equipment has very low levels of RF energy that it deemed to
comply without maximum permissive exposure evaluation (MPE). But it is desirable that it should be installed and operated with
at least 30cm and more between the radiator and person’s body (excluding extremities: hands, wrists, feet and ankles).

This equipment has been tested and found to comply with the limits for a Class A digital device pursuant to part 15 of the FCC rules.
These limits are designed to provide reasonable protection against harmful interference when the equipment is operated in a
commercial environment. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used
in accordance with the instruction manual, may cause harmful interference to radio communications. Operation of this equipment
in a residential area is likely to cause harmful interference in which case the user will be required to correct the interference at his
own expense.

If this equipment does cause interference to radio or television equipment reception, which can be determined by turning the
equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

® Reorient or relocate the receiving antenna.
®* Move the equipment away from the receiver.
® Plug the equipment into an outlet on a circuit different from that to which the receiver is powered.
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® Consult the dealer or an experienced radio/television technician for additional suggestions.

Any changes or modifications to the equipment not expressly approved by the party responsible for
compliance could void your authority to operate such equipment.

Industry Canada Compliance

This equipment complies with IC radiation exposure limits set forth for uncontrolled equipment and meets RSS-102 of
the IC radio frequency (RF) exposure rules. This equipment has very low levels of RF energy that it deemed to comply
without maximum permissive exposure elevation (MPE). Bit it is desireable that it should be installed and operated with
at least 30 cm or more between the radiator and person’s body (excluding extremities: hands, wrists, feet, and ankles).

This class A digital apparatus complies with Canadian ICES-003.
Cet appareil numérique de la classe A est conforme a la norme NMB-003 du Canada.

This device complies with Industry Canada licence-exempt RSS standard(s). Operation is subject to the following two
conditions: (1) this device may not cause interference, and (2) this device must accept any interference, including
interference that may cause undesired operation of the device.

Le présent appareil est conforme aux CNR d’Industrie Canada applicables aux appareils radio exempts de
licence. L’exploitation est autorisée aux deux conditions suivantes : (1) [’appareil ne doit pas produire de
brouillage, et (2) lutilisateur de ’appareil doit accepter tout brouilage radioélectrique subi, méme si le
brouillage est susceptible d’en compromettre le fonctionnement.
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IC RF Radiation Exposure Statement

When installing, locate or point this device away from the installer, so it does not emit RF field in excess of Health Canada’s limits
for the general population. Consult Safety Code 6 from Health Canada’s website at www.hc-sc.gc.ca/rpb.

IC Additional Statement with Detachable Antennas

This device 9with UHF Il modem) has been designated to operate with the antennas listed below and have a maximum gain of
2.4dBi. Antennas not included in this or having a gain greater than 2.4dBi are strictly prohibited for use with this device. The
required antenna impedance is 50 ohms.

GR-5 UHF Il 2.4dBi whip antenna
Manufacture/Type

420-450 MHz LAIRD or ANTENEX/G420BN
450-470 MHz LAIRD or ANTENEX/G450BN

The device (with FH915 modem) has been designated to operate with the antennas listed below and have a maximum gain of
2.1dBi. Antennas not included in this or having a gain greater than 2.1dBi are strictly prohibited for use with this device. The
required antenna impedance is 50 ohms.

GR-5 FH915 2.1dBi Sleeve Dipole Antenna
Manufacture/Type
890-960 MHz LARSEN SPDA17RP918

Connect Type: TNC male reverse polarity
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Community of Europe Compliance

The product described in this manual is in compliance with the R&TTE and EMC directives from the European Community.

European Community Declaration of Conformity with R&TTE Directive
1999/5/EC

The following standards were applied: (R&TTE Directive 1999/5/EEC)

® EN301489-1V1.8.1(2008-04)
® EN301489-17 V2.1.1 (2009-05)
® EN300328V1.7.1(2006-10)
® EN 60950-1: 2006 + A11:2009/A1:2010
® EN301489-3V1.4.1(2002-08)
® EN300440-2V1.4.1
The following CE mark is affixed to the device:

3

This is a Class A product. In a domestic environment this product may cause radio interference in which case
the user may be required to take adequate measures.
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Declaration of Conformity (R&TTE Directive 1999/5/EC)

esky
[Czech]

Dansk
[Danish]

Deutsch
[German]

Eesti
[Estonian]

English

Espafiol
[Spanish]

(Topcon) timto prohlasuje, Ze tento (GR-5) je ve shod se
zakladnimi pozadavky a dalSimi pislusSnymi ustanovenimi smrnice
1999/5/ES.

Undertegnede (Topcon) erklzerer herved, at fglgende udstyr
(GR-5) overholder de vaesentlige krav og gvrige relevante krav i
direktiv 1999/5/EF.

Hiermit erklart (Topcon) dass sich das Gerat (GR-5) in
Ubereinstimmung mit den grundlegenden Anforderungen und den
Ubrigen einschlagigen Bestimmungen der Richtlinie 1999/5/EG
befindet.

Kaesolevaga kinnitab (Topcon) seadme (GR-5) vastavust direktiivi
1999/5/EU pShinduetele ja nimetatud direktiivist tulenevatele
teistele asjakohastele satetele.

Hereby, (Topcon) declares that this (GR-5) is in compliance with
the essential requirements and other relevant provisions of
Directive 1999/5/EC.

Por medio de la presente (Topcon) declara que el (GR-5) cumple
con los requisitos esenciales y cualesquiera otras disposiciones
aplicables o exigibles de la Directiva 1999/5/CE.

Declaration of Conformity (R&TTE Directive 1999/5/EC) P/N: 7010-1004
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[Greek]

Frangais
[French]

Italiano
[Italian]

Latviski
[Latvian]

Lietuvi
[Lithuanian]

Nederlands
[Dutch]

Malti
[Maltese]

ME THN NAPQOYZA (Topcon Positioning Systems,
Inc.) AHAQNEI OTI (GRX1) ZYMMOPOQQNETAI
MPOZ TIZ OYZIQAEIZ ANAITHZEIZ KAI TIZ NOIMEZ
ZXETIKEZ AIATA=EIZ THZ OAHIIAZ 1599/5/EK.

Par la présente (Topcon) déclare que l'appareil (GR-5) est
conforme aux exigences essentielles et aux autres dispositions
pertinentes de la directive 1999/5/CE.

Con la presente (Topcon) dichiara che questo (GR-5) € conforme ai
requisiti essenziali ed alle altre disposizioni pertinenti stabilite dalla
direttiva 1999/5/CE.

Ar So (Topcon) deklar, ka (GR-5) atbilst Direktvas 1999/5/EK
btiskajm prasbm un citiem ar to saisttajiem noteikumiem.

Siuo (Topcon) deklaruoja, kad Sis (GR-5) atitinka esminius
reikalavimus ir kitas 1999/5/EB Direktyvos nuostatas.

Hierbij verklaart (Topcon) dat het toestel (GR-5) in

overeenstemming is met de essentiéle eisen en de andere
relevante bepalingen van richtlijn 1999/5/EG.

Hawnhekk, (Topcon), jiddikjara li dan (GR-5) jikkonforma mal-
tiijiet essenzjali u ma provvedimenti orajn relevanti li hemm fid-
Dirrettiva 1999/5/EC.

Declaration of Conformity (R&TTE Directive 1999/5/EC) P/N: 7010-1004
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Magyar
[Hungarian]

Polski
[Polish]

Portugués
[Portugues]

Slovensko
[Slovenian]

Slovensy
[Slovak]

Suomi
[Finnish]

Svenska
[Swedish]

Alulirott, (Topcon) nyilatkozom, hogy a (GR-5) megfelel a
vonatkozo alapvetd kovetelményeknek és az 1999/5/EC irdnyelv
egyéb eldirasainak.

Niniejszym, (Topcon) , deklaruj, e (GR-5) spenia wymagania
zasadnicze oraz stosowne postanowienia zawarte Dyrektywie
1999/5/EC.

(Topcon) declara que este (GR-5) esta conforme com os requisitos
essenciais e outras disposigdes da Directiva 1999/5/CE.

(Topcon) izjavlja, da je ta (GR-5) v skladu z bistvenimi zahtevami
in ostalimi relevantnimi doloili direktive 1999/5/ES.

(Topcon) tymto vyhlasuje, Zze (GR-5) spa zakladné poziadavky a
vSetky prislusné ustanovenia Smernice 1999/5/ES.

(Topcon) vakuuttaa taten etta (GR-5) tyyppinen laite on direktiivin
1999/5/EY oleellisten vaatimusten ja sita koskevien direktiivin
muiden ehtojen mukainen.

Harmed intygar (Topcon) att denna (GR-5) star I
Overensstdmmelse med de vasentliga egenskapskrav och dvriga
relevanta bestammelser som framgar av direktiv 1999/5/EG.
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#¢ TOPCON

Declaration of Conformity
With regard to the R&TTE Directive 1999/5/EC

Topcon P

y Inc EC Canformity for the f ing product:

Product Identification

Brand: Tapeon
Maodel Type: HiPeR SR
Model Number: 1000036-01
Description: GNSS Receiver
Manufacturer
Mame: Topcon Positioning Systems, Inc.
Address: 7400 National Drive, Livermore, CA 34550
Country: UsA
Tel: +1026-245-8300 Fax: +1925-245-8581

Means of Conformity
The product was tested and found in conformity with the foll

ETSI EN 301 488-17 v2.1.1 (2009-05) ETSI EN 301 489-1 v1 8.1 (2008-04)
ETSI EN 300 440-2  v1.4.1 (2010-08) ETSI EN 301 489-3 v1.4.1 (2002-08)
ETSIEN 300328  v1.7.1 (2006-10) CEMELEC EN 60950-1:2006:/A41:2010

All essential radio test suites have been carried out.

Fraser Smith ya 4

Director, Product Management, GNSS Managing Dirsctor

Topcon Positioning Systems, Inc. Topcon Europe Positioning B.V.
July 17, 2012 July 17, 2012

EU Representative

Name: Topcon Eurcpe Positioning BV,

Address:  Essebaan 11, 2908 LJ Capelle a/d ljssel
Country.  The Netherlands
Tel +31-10-4585077  Fax:  +31-10-4585045
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WEEE Directive

Following information is for EU-member states only:

The use of the symbol below indicates that this product may not be treated as household waste. By ensuring this product is
disposed of correctly, to help prevent potential negative consequences for the environment and human health, which could
otherwise be caused by inappropriate waste handling of this product. For more detailed information about the take-back and
recycling of this product, please contact a supplier where you purchased the product or consult.

I
Bluetooth Transmission Statements/Compliance

This Bluetooth device is compliant to the following profiles of the core spec version 2.1/2.1+EDR:

® Baseband

® HCI

® Link Manager

® Radio
The radio has been tested using the maximum antenna gain of 2.3 dBi and the Bluetooth qualification is valid for any antenna
with the same or less gain.
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Korean KC-RF Compliance
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S AL (Wireless specification): Bluetooth 2.1 + EDR
Z1}4= (Used Frequency): 2402-2480 MhZ

%= (the number of channels): 79

&2 (Antenna Power): 2.1 dBi

Al (Type of the modulation): GFSK, 8PSK

ISEE (Product Id Code): KCC-CRM-T8S-1000036-01
= (Applicant): Topcon Positioning Systems, Inc.

Model Name): GR-5 or GSX2
Year of manufacture): 2012

OISt Al E5 (Applicant Code): T8S

Korean KC-EMC Class A Statement
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2 (Type of equipment): GPS surveying device with Bluetooth radio

(
(
MIZA L MZ=IF (Manufacturer and country of origin): PC Partner , China
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Warranty

Topcon laser and electronic positioning equipment are guaranteed against defective material and workmanship under normal use
and application consistent with this Manual. The equipment is guaranteed for the period indicated, on the warranty card
accompanying the product, starting from the date that the product is sold to the original purchaser by Topcon’s Authorized
Dealers.!

During the warranty period, Topcon will, at its option, repair or replace this product at no additional charge. Repair parts and
replacement products will be furnished on an exchange basis and will be either reconditioned or new. This limited warranty does
not include service to repair damage to the product resulting from an accident, disaster, misuses, abuse or modification of the
product.

Warranty service may be obtained from an authorized Topcon warranty service dealer. If this product is delivered by mail,
purchaser agrees to insure the product or assume the risk of loss or damage in transit, to prepay shipping charges to the warranty
service location and to use the original shipping container or equivalent. A letter should accompany the package furnishing a
description of the problem and/or defect.

The purchaser’s sole remedy shall be replacement as provided above. In no event shall Topcon be liable for any damages or other
claim including any claim for lost profits, lost savings or other incidental or consequential damages arising out of the use of, or
inability to use, the product.

1. The warranty against defects in a Topcon battery, charger, or cable is 90 days.
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Glossary

Glossary

Base Station — A GNSS receiver set up over a known point, which is used to derive correction information for nearby Rover (mobile)
GNSS receivers.

Bluetooth® — Often used in place of cables, Bluetooth is open wireless technology for exchanging data over short distances from
fixed and mobile devices.

C
COMPASS - BeiDou Navigation Satellite System maintained and operated by China.

G

GALILEO — The satellite system currently being maintained and operated by the European Union (EU) and European Space Agency
(ESA).

GGD — GPS + GLONASS Dual Frequency signal tracking.

GLONASS - The GLObal NAvigation Satellite System maintained and operated by the Russian Federation.
GNSS - Global Navigation Satellite Systems, such as GPS and GLONASS.

GPS - The Global Positioning System maintained and operated by the United States Department of Defense.
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L
L1 —The primary L-band carrier used by GPS and GLONASS satellites to transmit satellite data.
L2 — The secondary L-band carrier used by GPS and GLONASS satellites to transmit satellite data.

Atesso|H

Light-Emitting Diode (LED) — Used as indicator lights on the receiver to display the status of the receiver’s components and
control receiver operations.

M
MAGNET Field™ — Data controller software that is part of the MAGNET software system.

MAGNET Office™ — Post-processing and CAD solution software for surveying and grade application. It is part of the MAGNET
software system.

MINTER - The receiver’s Minimum INTERface used to display and control data input and output.

N

Network RTK - Collects satellite observations from the reference stations within the network and sends RTK corrections to the
Rover.

(0]

Option Authorization File (OAF) — This enables the specific features that a customer purchases.
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Phase Center of Antenna — The point from which the electromagnetic radiation spreads spherically outward, with the phase of
the signal being equal at any point on the sphere.

Pocket-3D - Field controller software by Topcon that supports both GNSS and TS.

R

Real-Time Kinematic (RTK) — A precise method of real-time surveying. RTK enables you to check the measurement quality
without having to process the data.

Root Mean Square (RMS) — Statistical measure of the magnitude of a varying quantity.

Rover — A mobile GNSS receiver and data collector used for determining location in the field.

S

Satellite-Based Augmentation Systems (SBAS) — Complements existing global navigation systems. SBAS transmits differential
corrections and messages for navigation satellites that are within sight of a network or reference stations in a wide area, such
as a continent.

Static Survey — Typically uses a network or multiple baseline approach for positioning. This method provides the highest
accuracy and requires the longest observation times.

T

Topcon Receiver Utility (TRU) — Hardware configuration software for receivers and peripheral devices. TRU is included on the
GPS+ Software CD that accompanied your receiver.

U
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Universal Serial Bus (USB) — A connection standard used by devices, such as a receiver, controller, computer, etc.

Atesso|H
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